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NEW QUESTION 1
Which accounts can be selected for use in the Windows discovery process? (Choose two.)

A. an account stored in the Vault

B. an account specified by the user
C. the Vault Administrator

D. any user with Auditor membership
E. the PasswordManager user

Answer: AB

Explanation:

During the Windows discovery process in CyberArk Defender PAM, accounts that can be selected for use include an account that is already stored in the Vault
and an account that is specified by the user. The discovery process scans predefined machines for new and modified accounts and their dependencies. After the
scan, accounts that should be onboarded into the Vault for secure and automatic management are identified12. References: The information provided is based on
general knowledge of CyberArk PAM best practices and the account discovery process as outlined in CyberArk’s official documentationl

NEW QUESTION 2
Which one the following reports is NOT generated by using the PVWA?

A. Accounts Inventory
B. Application Inventory
C. Sales List

D. Convince Status

Answer: C

Explanation:

The PVWA can generate various reports on the privileged accounts and applications in the system, based on different filters and criteria. However, the Safes List
report is not one of them. The Safes List report is generated by using the PrivateArk Client, and it provides a list of Safes and their properties according to location.
References:

Defender-PAM Study Guide, Reports and Audits

NEW QUESTION 3
The primary purpose of exclusive accounts is to ensure non-repudiation (Individual accountability).

A. TRUE
B. FALSE

Answer: A

Explanation:

The primary purpose of exclusive accounts is to ensure non-repudiation (individual accountability). Exclusive accounts are accounts that can only be used by one
user at a time, and are locked during usage. This means that no other user can access the same account until the current user releases it or the session expires.
By using exclusive accounts, the organization can enforce individual accountability and traceability for the actions performed on the target systems. Exclusive
accounts also reduce the risk of credential theft and unauthorized access, as the passwords are changed every time they

are retrieved by a userl. Exclusive accounts can be configured in the Master Policy under the Password Management section, by enabling the Exclusive Access
rule2. References:

? 1: The Master Policy, One Time Password subsection

? 2: The Master Policy, Exclusive Access subsection

NEW QUESTION 4
Which Automatic Remediation is configurable for a PTA detection of a “Suspected Credential Theft"?

A. Add to Pending

B. Rotate Credentials

C. Reconcile Credentials
D. Disable Account

Answer: B

Explanation:

For a Privileged Threat Analytics (PTA) detection of a “Suspected Credential Theft,” the automatic remediation that can be configured is Rotate Credentials. This
remediation action is designed to automatically initiate password changes when PTA identifies a suspected credential threat, such as a credential theft event. By
rotating the credentials, CyberArk ensures that the potentially compromised credentials are changed, thus mitigating the risk of unauthorized access1.
References:

? CyberArk’s official documentation on configuring PTA remediations, which includes information on automatic password rotation for suspected credential
threats?2.
? Additional details on the remediation actions that can be configured for different types of PTA detections, including Suspected Credential Theftl.

NEW QUESTION 5
Which parameters can be used to harden the Credential Files (CredFiles) while using CreateCredFile Utility? (Choose three.)

A. Operating System Username

B. Host IP Address

C. Client Hostname

D. Operating System Type (Linux/Windows/HP-UX)
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E. Vault IP Address
F. Time Frame

Answer: BCE

Explanation:

When using the CreateCredFile Utility to harden Credential Files (CredFiles), it is important to include parameters that enhance security. The Host IP Address,
Client Hostname, and Vault IP Address are parameters that can be used to specify the environment in which the CredFile is valid, thereby restricting its use to
specific machines or networksl. This helps prevent unauthorized access to the CredFile and ensures that it is only used in the intended context.

References:

? CyberArk’s official documentation on the CreateCredFile utility provides insights into the security mechanisms used to protect credential files, including the use
of environmental key materials such as application-based, machine-based, and component-based materialsl.

? For a deeper understanding of how to secure Credential Files and the use of the CreateCredFile Utility, refer to the CyberArk Defender PAM course materials
and study guide2.

NEW QUESTION 6
DRAG DROP
For each listed prerequisite, identify if it is mandatory or not mandatory to run the PSM Health Check.

PSM service installed on
Windows 2008 R2, Windows Dirag answar here Mandatory
2012 R2, or Windows 2016 '

P5M service installed on
Windows 2012 R2, Windows Di
2016, or Windows 2019

ap answer here Not Mandatory

A valid SSL certificate is
installed on the Web Server -

Web Server (115 8.5) role is
installed

A. Mastered
B. Not Mastered

Answer: A

Explanation:

According to the CyberArk documentationl, the prerequisites for running the PSM Health Check are:

? PSM service installed on Windows 2016 or Windows 2019

? Web Server (IIS 8.5) role is installed

? A valid SSL certificate is installed on the Web Server

Therefore, these prerequisites are mandatory for the PSM Health Check to work properly. The PSM service installed on Windows 2008 R2 is hot mandatory, as it
is not supported by the PSM Health Check2.

References: PSM Health Check, PSM Health Check - CyberArk

Prerecuisite Mandatory or Mot Mandatory

PEM service installed on Windows 2008 B2, Windows Mot Mandatony
2012 R2. or Windows 2016

PEM zervice installed on Windows 2012 R2, Windows WMandatory
2016 or Windows 2019

A vald S5L certificate is installed on the server Mandatory

Web Server (115 &5) role is installed Mandatory

NEW QUESTION 7
The vault supports Role Based Access Control.

A. TRUE
B. FALSE

Answer: A

Explanation:

The vault supports Role Based Access Control (RBAC), which is a method of granting access to resources based on the roles of users or groups. RBAC enables
the administrator to define roles that represent different functions or responsibilities in the organization, and assign permissions to those roles according to the
principle of least privilege. Users or groups can then be assigned to one or more roles, and inherit the permissions of those roles. RBAC simplifies the
management of access control by reducing the complexity and redundancy of assigning permissions to individual users or groups. RBAC also enhances security
and compliance by ensuring that users or groups only have the minimum level of access required to perform their tasks1.

References:

? 1: Role Based Access Control

NEW QUESTION 8
Which keys are required to be present in order to start the PrivateArk Server service?
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A. Recovery public key
B. Recovery private key
C. Server key

D. Safe key

Answer: AC

Explanation:

The server key and the public recovery key are required to be present in order to start the PrivateArk Server service. The server key opens the Vault, much like
the key of a physical Vault. The public recovery key is part of the asymmetric recovery key that enables the Master User to log on to the Vault in case of a disaster.
The server key and the public recovery key are usually stored on a removable media, such as a disk or CD, so that they can be safely secured in a physical safe.
The recovery private key and the safe key are not needed to start the PrivateArk Server service. The recovery private key is only used for recovery purposes and
the safe key is only used to access a specific safe that is defined with an external key. References: Server keys, Server Components

NEW QUESTION 9
When the CPM connects to a database, which interface is most commonly used?

A. Kerberos
B. ODBC
C. VBScript
D. Sybase

Answer: B

Explanation:

The Central Policy Manager (CPM) in CyberArk most commonly uses the ODBC (Open Database Connectivity) interface when connecting to a database. ODBC
is a standard API for accessing database management systems (DBMS). The CPM supports remote password management on all databases that support ODBC
connections, and the machine running the CPM must support ODBC, version 2.7 and higherl. References:

? CyberArk Docs: Databases that support ODBC connectionsl

NEW QUESTION 10
You have been given the requirement that certain accounts cannot have their passwords updated during business hours.
How can you set up a configuration to meet this requirement?

A. Change settings on the CPM configuration safe so that access is permitted after business hours only.
B. Update the password change parameters of the platform to match the permitted time frame.

C. Disable automatic CPM management for all accounts that are assigned to this platform.

D. Add an exception to the Master Policy to allow the action for this platform during the permitted time.

Answer: B

Explanation:

To ensure that certain accounts do not have their passwords updated during business hours, you can configure the password change parameters within the
platform settings to specify the permitted time frame for updates. This involves setting the FromHour andToHour parameters to define a window outside of
business hours during which the CyberArk Central Policy Manager (CPM) will perform automatic password changesl. By doing so, you can control when password
changes occur and ensure compliance with the specified requirement.

References:

? CyberArk Community: Discussion on configuring automatic password change parameters

NEW QUESTION 10
Which Vault authorization does a user need to have assigned to able to generate the "Entitlement Report" from the reports page in PVWA? (Choose two.)

A. Manage Users

B. Audit Users

C. Read Activity

D. View Entitlements
E. List Accounts

Answer: BD

Explanation:

D. View Entitlements: This authorization allows the user to view the entitlements, which is essential for generating reports that include access control and
authorization levels on accounts.

* B. Audit Users: Having ‘Audit Users’ permission is crucial as it enables the user to perform audit-related activities, which are typically part of generating
entitlement reports12.

These authorizations ensure that the user has the necessary permissions to access and compile the data required for the Entitlement Report within the CyberArk
PVWA.

NEW QUESTION 12
As long as you are a member of the Vault Admins group, you can grant any permission on any safe that you have access to.

A. TRUE
B. FALSE

Answer: B

Explanation:
Being a member of the Vault Admins group does not automatically grant you any permission on any safe that you have access to. The Vault Admins group is a
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predefined group that is created during the installation or upgrade of the vault. This group has the Vault Admin authorization, which allows its members to perform
administrative tasks on the vault, such as managing users, groups, platforms, policies, and safesl. However, this authorization does not include any safe member
authorizations, such as View, Retrieve, Use, or Manage Safe2. Therefore, to grant any permission on a safe, you need to be added as a safe member with the
appropriate authorizations, either directly or through another group. The Vault Admins group can be added to safes with all safe member authorizations, but this is
not done automatically for all safes. By default, this group is only added to a number of system safes, such as the Password Manager Safe, the PVYWAConfig Safe,
and the Notification Methods Safe3. For other safes, the Vault Admins group can be added manually by the safe owner or another user with the Manage Safe
authorization4. References:

? 1: Predefined users and groups, Predefined groups subsection

? 2: [CyberArk Privileged Access Security Implementation Guide], Chapter 3: Managing Safes, Section: Safe Authorizations, Table 2-1: Safe Authorizations

? 3: What default groups can be automatically added to Safes when they are created?

? 4: [CyberArk Privileged Access Security Administration Guide], Chapter 3: Managing Safes, Section: Adding Safe Members

NEW QUESTION 13
DRAG DROP
Match each automatic remediation to the correct PTA security event.

Add To Pending unmanaged privileged account
Rotate Credentials suspicious password change
Reconcile Credentials suspected credential thef
A. Mastered

B. Not Mastered
Answer: A

Explanation:

In CyberArk’s Privileged Threat Analytics (PTA), automatic remediations are actions that can be configured to respond to specific security events. For the event of
an unmanaged privileged account, the remediation “Add To Pending” is used to add the account to the pending accounts queue. When there is a suspected
credential theft, “Rotate Credentials” is the remediation that initiates a password change. Lastly, for a suspicious password change event, “Reconcile Credentials”
is the remediation that ensures the credentials are correct and validl.

References:

? CyberArk Docs: Configure security events

NEW QUESTION 17
A logon account can be specified in the platform settings.

A. True
B. False

Answer: A

Explanation:

A logon account can be specified in the platform settings of CyberArk, a security software that manages privileged accounts and credentials. According to the
CyberArk documentationl, "In the Account Details window, in the CPM pane, in the accounts section, you can associate either a logon account or a reconciliation
account. If a default logon account has been configured for the platform that manages this account, that account is listed. You can associate another logon account
or leave the default account as it is."1 A logon account is an account that is used to log on to a target system and perform password management operations on
other accounts. A reconciliation account is an account that is used to restore access to a target system when the logon account fails.

NEW QUESTION 22
When are external vault users and groups synchronized by default?

A. They are synchronized once every 24 hours between 1 AM and 5 A

B. Most Voted

C. They are synchronized once every 24 hours between 7 PM and 12 AM.
D. They are synchronized every 2 hours.

E. They are not synchronized according to a specific schedule.

Answer: A

Explanation:

By default, external vault users and groups are synchronized once every 24 hours between 1 AM and 5 AM. This synchronization schedule is determined by the
AutoSyncExternalObjects parameter in the DBParm.ini file, which specifies that the Vault's external users and groups will be synchronized with the External
Directory during this time framel.

References:

? CyberArk Docs - Synchronize External Users and Groups in the Vault with the External Directory

NEW QUESTION 25
Where can you assign a Reconcile account? (Choose two.)

A. in PVWA at the account level
B. in PVWA in the platform configuration
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C. in the Master policy of the PVWA
D. at the Safe level
E. in the CPM settings

Answer: AB

Explanation:

A Reconcile account can be assigned in the Privileged Vault Web Access (PVWA) at both the account level and within the platform configuration. At the account
level, a Reconcile account password can be defined which will override the account specified in the platform1. In the platform configuration, you can navigate to
Platform Management, select the platform, edit it, and then expand Automatic Password Management to enter the values in the ‘ReconcileAccountSafe’ and
‘ReconcileAccountName’ fields, which will apply to all accounts attached to that specific platform?2.

References:

? CyberArk Docs - Reconcile Passwordl

? CyberArk Community - Associate reconcile account with a specific platform

NEW QUESTION 29
You are concerned about the Windows Domain password changes occurring during business hours.
Which settings must be updated to ensure passwords are only rotated outside of business hours?

A. In the platform policy - Automatic Password Management > Password Change > ToHour & FromHour
B. in the Master Policy Account Change Window > ToHour & From Hour

C. Administration Settings - CPM Settings > ToHour & FromHour

D. On each individual account - Edit > Advanced > ToHour & FromHour

Answer: B

Explanation:

To ensure that Windows Domain password changes occur outside of business hours, the settings that must be updated are found in the Master Policy under the
Account Change Window section. Here, you can specify the ToHour and FromHour to define the time frame outside of which the passwords should be rotated.
This setting allows you to control when password changes can occur, ensuring

that they do not interfere with business operations by taking place during non-business hoursl.

References:

? CyberArk Docs - Set password policies

NEW QUESTION 31
The Privileged Access Management solution provides an out-of-the-box target platform to manage SSH keys, called UNIX Via SSH Keys.
How are these keys managed?

A. CyberArk stores Private keys in the Vault and updates Public keys on target systems.

B. CyberArk stores Public keys in the Vault and updates Private keys on target systems.

C. CyberArk does not store Public or Private keys and instead uses a reconcile account to create keys on demand.
D. CyberArk stores both Private and Public keys and can update target systems with either key.

Answer: A

Explanation:

SSH keys are a way to authenticate to a target machine with a privileged account, and are subject to the same risks and challenges as privileged passwords.
CyberArk provides an out-of-the-box target platform to manage SSH keys, called UNIX Via SSH Keys, which simplifies and automates SSH keys lifecycle
management. This platform works as follows:

? CyberArk stores the private keys in the Vault, where they benefit from all the security and accessibility features of the Vault, such as encryption, auditing, and
backup.

? CyberArk updates the public keys on the target systems, using a parent account that has access to the file that contains the public key, such as
~/.ssh/authorized_keys. CyberArk can generate new random SSH key pairs and update the public keys on the target systems according to the organizational
policy, such as after a single use, after a predefined period, or manually.

? CyberArk can also verify that the private and public keys are synchronized, and reconcile them if they are not, using a reconcile account that can reset the SSH
key pairs on the target systems.

References: Manage SSH Keys, Use SSH Keys

NEW QUESTION 32

You are onboarding 5,000 UNIX root accounts for rotation by the CPM. You discover that the CPM is unable to log in directly with the root account and will need to
use a secondary account.

How should this be configured to allow for password management using least privilege?

A. Configure each CPM to use the correct logon account.

B. Configure each CPM to use the correct reconcile account.

C. Configure the UNIX platform to use the correct logon account.

D. Configure the UNIX platform to use the correct reconcile account.

Answer: C

Explanation:

When onboarding a large number of UNIX root accounts for password rotation by the Central Policy Manager (CPM), and the CPM cannot log in directly with the
root account, it is necessary to configure the UNIX platform to use a secondary logon account that has the appropriate privileges. This secondary account should
have the minimum necessary permissions to perform password management tasks, adhering to the principle of least privilegel. By configuring the UNIX platform
with the correct logon account, the CPM can use this account to manage the root accounts securely and efficiently.

References:

? CyberArk’s official documentation on Least Privileges and Privileged Access Manager provides guidance on configuring on-demand privileges for UNIX
environments, which includes setting up the correct logon account for tasks that require elevated privileges1.

? Additional information on managing UNIX and Linux accounts, including the configuration of logon and reconcile accounts, can be found in the Unix plugin
documentation for CyberArk
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NEW QUESTION 37
DRAG DROP
Match each key to its recommended storage location.

Store on the Vault Server

Recovery Private Ke Drag answer here . .
: ! i Disk Drive

Recovery Public Key s e Store in a Hardware Security

Maodule
Server Key Drag answer hiere Store in a Physical Safe
55H Keys Drag answer here Store in the Vault

A. Mastered
B. Not Mastered

Answer: A

Explanation:

? The recommended storage locations for each key are as follows:

? Recovery Private Key: It is recommended to store the Recovery Private Key on the Vault Server Disk Drive. This is because the Recovery Private Key is used to
decrypt the data stored in the Vault.

? Recovery Public Key: It is recommended to store the Recovery Public Key in a Hardware Security Module. This is because the Recovery Public Key is used to
encrypt the data stored in the Vault.

? Server Key: It is recommended to store the Server Key in a Physical Safe. This is because the Server Key is used to open the Vault, much like the key of a
physical Vault. The key is required to start the Vault, after which the Server Key can be removed until the Server is restarted. When the Vault is stopped, the
information stored in the Vault is completely inaccessible without that key.

? SSH Keys: It is recommended to store the SSH Keys in the Vault. This is because the SSH Keys are used to connect to remote machines using the SSH
protocol. The Vault can manage the passwords and sessions for the SSH Keys and provide secure access to the target systems.

References: Server keys - CyberArk, Cyberark Key Storage Plugin (Enterprise) - Rundeck

NEW QUESTION 42
Which PTA sensors are required to detect suspected credential theft?

A. Logs, Vault Logs

B. Logs, Network Sensor, Vault Logs
C. Logs, PSM Logs, CPM Logs

D. Logs, Network Sensor, EPM

Answer: B

Explanation:

Suspected credential theft is a detection that PTA reports when a user connects to a machine or a cloud service without first retrieving the required credentials
from the Vault. To detect this event, PTA requires the following sensors:

? Logs: This sensor collects log data from various sources, such as SIEM, Unix, AWS, and Azure, and forwards it to the PTA Server for analysis.

? Network Sensor: This sensor taps the network and collects network traffic data, which is used by the PTA Server to run deep packet inspection algorithms and
detect cyber attacks, such as PAC, OverPass the Hash, and Golden Ticket.

? Vault Logs: This sensor collects log data from the Vault and forwards it to the PTA Server for analysis. The Vault logs contain information about the users’
activities in the Vault, such as password retrieval, session initiation, and audit records.

References: What Detections Does PTA Report?, PTA Network Sensors

NEW QUESTION 47
To ensure all sessions are being recorded, a CyberArk administrator goes to the master policy and makes configuration changes.
Which configuration is correct?

A. Require privileged session monitoring and isolation = inactive; Record and save session activity = active.
B. Require privileged session monitoring and isolation = inactive; Record and save session activity = inactive.
C. Require privileged session monitoring and isolation = active; Record and save session activity = active.

D. Require privileged session monitoring and isolation = active; Record and save session activity = inactive.

Answer: C

Explanation:

This configuration ensures that privileged sessions are monitored and isolated, and all session activities are recorded and saved for future reference 1.
NEW QUESTION 52

Which user(s) can access all passwords in the Vault?

A. Administrator

B. Any member of Vault administrators

C. Any member of auditors

D. Master

Answer: D

Explanation:
According to the CyberArk Defender PAM documentationl, the Master user is the only user that can access all passwords in the Vault. The Master user is a
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special user that is created during the initial installation of the Vault and has full permissions on all Safes and accounts in the Vault. The Master user can also
perform administrative tasks, such as backup and restore the Vault, change the Vault license, and manage the recovery key. The Master user is the only user that
can log on to the Vault in case of a disaster using the recovery key. The Master user’s password is not stored in the Vault and cannot be changed or retrieved by
any other user.

The Administrator user is a predefined user that is created during the initial installation of the Vault and has the Vault Admin authorization. The Administrator user
can perform administrative tasks, such as create and manage users and groups, define platforms and policies, and monitor Vault activity. However, the
Administrator user cannot access any passwords in the Vault unless they are explicitly added as a member of a Safe that contains the passwords2.

The Vault administrators group is a predefined group that is created during the initial installation of the Vault and has the Vault Admin authorization. The members
of the Vault administrators group can perform the same administrative tasks as the Administrator user, but they cannot access any passwords in the Vault unless
they are explicitly added as a member of a Safe that contains the passwords2.

The auditors group is a predefined group that is created during the initial installation of the Vault and has the Audit Users authorization. The members of the
auditors group can view

and generate reports on the Vault activity, but they cannot access any passwords in the Vault unless they are explicitly added as a member of a Safe that contains
the passwords2. References:

? Master User - CyberArk

? Predefined users and groups - CyberArk

NEW QUESTION 57

Due to network activity, ACME Corp’s PrivateArk Server became active on the OR Vault while the Primary Vault was also running normally. All the components
continued to point to the Primary Vault.

Which steps should you perform to restore DR replication to normal?

A. Replicate data from DR Vault to Primary Vault > Shutdown PrivateArk Server on DR Vault > Start replication on DR vault

B. Shutdown PrivateArk Server on DR Vault > Start replication on DR vault

C. Shutdown PrivateArk Server on Primary Vault > Replicate data from DR Vault to Primary Vault > Shutdown PrivateArk Server on DR Vault > Start replication on
DR vault

D. Shutdown PrivateArk Server on DR Vault > Replicate data from DR Vault to Primary Vault > Shutdown PrivateArk Server on DR Vault > Start replication on DR
vault

Answer: B

Explanation:

To restore DR replication to normal after network activity caused the PrivateArk Server on the DR Vault to become active while the Primary Vault was also
running, you should first shut down the PrivateArk Server on the DR Vault. This ensures that the DR Vault is no longer active and can be prepared for replication.
After shutting down the server, you should then start the replication process on the DR Vault to synchronize the data from the Primary Vaultl.

References:

? CyberArk’s official documentation on initiating a DR failback to the Production

Vault provides a detailed procedure for restoring DR replication to normall.

? Additional information on monitoring backup and DR replications can be found in CyberArk’s documentation2.

? For further study and understanding of the CyberArk Defender PAM course objectives and documents, the official CyberArk training resources and study guides
are recommended3.

NEW QUESTION 60
CyberArk implements license limits by controlling the number and types of users that can be provisioned in the vault.

A. TRUE
B. FALSE

Answer: B

Explanation:

CyberArk does not implement license limits by controlling the number and types of users that can be provisioned in the vault. CyberArk implements license limits
by controlling the number and types of users that can authenticate to the vault and use its features. The license limits are based on the user types and objects that
are defined in the vault, such as Vault Users, LDAP Users, LDAP Groups, Safes, Accounts, etc. The license limits are enforced by the License Manager, which is a
service that runs on the Vault server and monitors the license usage. The License Manager can send notifications and alerts when the license usage reaches
certain thresholds, and can also block or allow access to the vault based on the license status1.

References:

? 1: Manage the CyberArk License

NEW QUESTION 61
A user needs to view recorded sessions through the PVWA.
Without giving auditor access, which safes does a user need access to view PSM recordings? (Choose two.)

A. Recordings safe

B. Safe the account is in

C. System safe

D. PVWAConfiguration safe
E. Vaultinternal safe

Answer: AB

Explanation:

To view recorded sessions through the PVWA without having auditor access, a user needs access to two specific safes: the Recordings safe and thesafe the
account is in. The Recordings safe is where the PSM session recordings are stored, and users need permission to access this safe to view the recordings.
Additionally, users need access to the safe where the account associated with the recorded session is stored, as this is where the session details and permissions
are managed12.

References:

? CyberArk Docs - Configure video and text recordings3

? CyberArk Community - Viewing PSM recorded sessions1
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NEW QUESTION 64
An auditor needs to login to the PSM in order to live monitor an active session. Which user ID is used to establish the RDP connection to the PSM server?

A. PSMConnect

B. PSMMaster

C. PSMGwUser

D. PSMAdminConnect

Answer: A

Explanation:

The PSMConnect user is a local user on the PSM server that is used to establish RDP connections to the PSM server. The PSMConnect user has the following
permissions: Log on locally, Log on as a batch job, and Allow log on through Remote Desktop Services. The PSMConnect user is also a member of the local group
PSMuUsers, which has access to the PSM web console. The other user IDs are not used for RDP connections to the PSM server. The PSMMaster user is a local
user on the PSM server that is used to run the PSM services. The PSMGwUser user is a local user on the PSM server that is used to run the PSM Gateway
service. The PSMAdminConnect user is a local user on the PSM server that is used to connect to the PSM web console as an administrator. References:
Privileged Session Manager, Defender - PAM, PSM for Web Console, Connect through PSM for SSH

NEW QUESTION 65
Which certificate type do you need to configure the vault for LDAP over SSL?

A. the CA Certificate that signed the certificate used by the External Directory
B. a CA signed Certificate for the Vault server

C. a CA signed Certificate for the PVWA server

D. a self-signed Certificate for the Vault

Answer: A

Explanation:

To enable SSL-based encryption for LDAP integration, the Vault machine and the PVWA machine need to trust the certificate used by the External Directory. This
can be achieved by importing the CA Certificate that signed the certificate used by the External Directory into the Windows certificate store on both the Vault and
PVWA machines. This will facilitate an SSL connection between the Vault and the External Directory. References: Configure the Vault for LDAP, Configure LDAPS
in CyberArk. What certificate | need to use?

NEW QUESTION 68
How do you create a cold storage backup?

A. On the DR Vault, install PAReplicate according to the Installation guide, configure the logon ini file, and define the Schedule tasks for full and incremental
backups.

B. Install the Vault Backup utility on a different machine from the Enterprise Password Vault server and trigger the full backup.

C. Configure the backup options in the PVWA.

D. On the DR Vault, configure the cold storage backup path in TSParm.ini file.

Answer: A

Explanation:

To create a cold storage backup, you would install thePAReplicate utility

on the DR Vault as per the installation guide. This utility is part of the CyberArk Vault's backup solution and is used to export the encrypted contents of your Safes
securely to a computer outside the Vault environment. After installation, you would configure the logon ini file with the necessary credentials and define the
scheduled tasks for both full and incremental backups. This ensures that the Safes are regularly backed up and that the data is available for recovery if needed1.
References:

? CyberArk’s official documentation on using the CyberArk Backup Process, which includes details on the PAReplicate utility and how to configure it for cold
storage backupsl.

? Additional information on installing the Vault Backup Utility and configuring backup options, which provides context for the correct answer

NEW QUESTION 72
It is possible to leverage DNA to provide discovery functions that are not available with auto-detection.

A. TRUE
B. FALSE

Answer: A

Explanation:

It is possible to leverage DNA to provide discovery functions that are not available with auto-detection. Auto-detection is a feature that enables the CPM to
automatically discover and onboard accounts on target systems that are associated with a specific platform. Auto-detection can be configured in the Platform
Management settings for each platform that supports this functionality. However, auto-detection has some limitations, such as requiring the CPM to have access to
the target system, not supporting all platforms, and not providing comprehensive information about the accounts and their security risks1. DNA, on the other hand,
is a standalone scanning tool that can discover and audit privileged accounts across the network, regardless of the platform or the CPM access. DNA can provide
additional discovery functions, such as identifying machines vulnerable to Pass-the-Hash attacks, collecting reliable and comprehensive audit information, and
generating reports and visual maps that evaluate the privileged account security status in the organization2. DNA can also be used before or independently of the
CyberArk PAM solution, as it does not require agents to be installed on target systems2. References:

? 1: Auto-detection
? 2. CyberArk DNA Overview

NEW QUESTION 77
Which of the following properties are mandatory when adding accounts from a file? (Choose three.)

A. Safe Name
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B. Platform ID

C. All required properties specified in the Platform
D. Username

E. Address

F. Hostname

Answer: ABC

Explanation:

When adding accounts from a file, certain properties are mandatory to ensure that the accounts can be properly managed within the CyberArk Privileged Access
Security system. The Safe Name is required to determine where the account will be stored.

The Platform ID is necessary to apply the correct management policies to the account. Additionallya, Il required properties specified in the Platform must be
included to meet the specific requirements for account management as defined by the platform configurationl.

References:

? CyberArk’s official documentation on adding multiple accounts from a file, which outlines the mandatory information needed for each account, including Safe
Name, Platform ID, and other required properties based on the account’s policy requirements1.

NEW QUESTION 81
What is the name of the Platform parameters that controls how long a password will stay valid when One Time Passwords are enabled via the Master Policy?

A. Min Validity Period
B. Interval

C. Immediate Interval
D. Timeout

Answer: A

Explanation:

The name of the Platform parameter that controls how long a password will stay valid when One Time Passwords are enabled via the Master Policy is Min Validity
Period. This parameter defines the number of minutes to wait from the last retrieval of the account until it is replaced. This gives the user a minimum period to be
able to use the password before it is changed by the CPM. The Min Validity Period parameter can be configured in the Platform Management settings for each
platform that supports One Time Passwords. The default value is 60 minutes, but it can be modified according to the organization’s security policyl. The Min
Validity Period parameter is also used to release exclusive accounts automaticallyl. References:

? 1. Privileged Account Management, Min Validity Period subsection

NEW QUESTION 85
You have been asked to turn off the time access restrictions for a safe. Where is this setting found?

A. PrivateArk Client
B. RestAPI

C. PVWA

D. Vault

Answer: C

Explanation:

The setting to turn off the time access restrictions for a safe is found in the Password Vault Web Access (PVWA). The PVWA provides a web interface through
which users can manage safes, including setting and modifying various safe properties such as access restrictions. By accessing the safe settings in the PVWA,
you can adjust the time access restrictions as requiredl.

References:

? CyberArk Docs: Safe Settingsl

NEW QUESTION 86

You have been asked to create an account group and assign three accounts which belong to a cluster. When you try to create a new group, you receive an
unauthorized error; however, you are able to edit other aspects of the account properties.

Which safe permission do you need to manage account groups?

A. create folders

B. specify next account content
C. rename accounts

D. manage safe

Answer: D

Explanation:

To manage account groups, you need the manage safe permission, which allows you to create, update, and delete account groups in a safe. The other
permissions are not related to account groups. The create folders permission allows you to create folders in a safe. The specify next account content permission
allows you to specify the next password or SSH key for an account. The rename accounts permission allows you to rename accounts in a safe. References:
Manage account groups, Safe member permissions

NEW QUESTION 88
When running a “Privileged Accounts Inventory” Report through the Reports page in PVWA on a specific safe, which permission/s are required on that safe to
show complete account inventory information?

A. List Accounts, View Safe Members

B. Manage Safe Owners

C. List Accounts, Access Safe without confirmation
D. Manage Safe, View Audit

The Leader of IT Certification visit - https://www.certleader.com



CertLeadera 100% Valid and Newest Version PAM-DEF Questions & Answers shared by Certleader

Toader of IT Cortifications https://www.certleader.com/PAM-DEF-dumps.html (239 Q&AS)

Answer: A

Explanation:

The Privileged Accounts Inventory Report provides information about all the privileged accounts in the system, based on different filters, such as safe, platform,
policy, and owner. To run this report through the Reports page in PVWA on a specific safe, the user needs to have the following permissions on that safe:

? List Accounts: This permission allows the user to view the accounts in the safe and their properties, such as nhame, address, platform, and policy.

? View Safe Members: This permission allows the user to view the members of the safe and their authorizations, such as owners, users, and groups.

These permissions are required to show complete account inventory information for the specific safe. Other permissions, such as Manage Safe Owners, Access
Safe without confirmation, Manage Safe, and View Audit, are not relevant for this report. References: Reports and Audits - CyberArk, Safe Member Authorizations

NEW QUESTION 91
For a safe with Object Level Access enabled you can turn off Object Level Access Control when it no longer needed on the safe.

A. TRUE
B. FALSE

Answer: B

Explanation:

According to the CyberArk documentationl, once Object Level Access Control is enabled for a Safe, it cannot be disabled. This feature allows granular control
over user access to passwords and files in the Safe, regardless of their Safe level member authorizations2. To enable Object Level Access Control, users need to
have the Manage Safe authorization in the Vaultl.

NEW QUESTION 95
In your organization the “click to connect” button is not active by default. How can this feature be activated?

A. Policies > Master Policy > Allow EPV transparent connections > Inactive

B. Policies > Master Policy > Session Management > Require privileged session monitoring and isolation > Add Exception
C. Policies > Master Policy > Allow EPV transparent connections > Active

D. Policies > Master Policy > Password Management

Answer: C

Explanation:

The “click to connect” button is a feature that allows users to connect to target systems without entering their credentials manually. It is also known as EPV
transparent connections or PSM transparent connections. To activate this feature, you need to enable the Allow EPV transparent connections parameter in the
Master Policy. This parameter determines whether users can use the “click to connect” button to initiate a privileged session from the PVWA. If the parameter is
set to Active, the button is enabled and users can connect to target systems with one click. If the parameter is set to Inactive, the button is disabled and users need
to copy the credentials and paste them in the target system login screen. References: Connect and configure - CyberArk, How to enable/disable Connect button in
PVWA console - force.com

NEW QUESTION 96
PSM captures a record of each command that was executed in Unix.

A. TRIE
B. FALSE

Answer: A

Explanation:

PSM captures a record of each command that was executed in Unix by using the SSH text recorder. This is a feature that enables PSM to record all the
keystrokes that are typed during privileged sessions on SSH connections, including Unix systems. The SSH text recorder can be configured in the Platform
Management settings for each platform that uses the SSH protocol. The text recordings are stored and protected in the Vault server and are accessible to
authorized auditors. The text recordings can also be used for auditing and compliance purposes, as they provide a detailed trace of the actions performed by the
users on the target systemsl. References:

? 1: Introduction to PSM for SSH, How it works subsection, Text recordings paragraph

NEW QUESTION 99
The Active Directory User configured for Windows Discovery needs which permission(s) or membership?

A. Member of Domain Admin Group
B. Member of LDAP Admin Group
C. Read and Write Permissions

D. Read Only Permissions

Answer: D

Explanation:

The Active Directory User configured for Windows Discovery requiresRead Only Permissions. This level of permission allows the user to query and discover
objects within the Active Directory without the ability to modify any objects or settings. Having read- only access is sufficient for discovery purposes, as it enables
the user to retrieve necessary information without posing a risk of unintended changes to the directoryl.

References:

? Microsoft Learn: Configure discovery methodsl

NEW QUESTION 101
What is the configuration file used by the CPM scanner when scanning UNIX/Linux devices?
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A. UnixPrompts.ini
B. plink.exe

C. dbparm.ini

D. PVConfig.xml

Answer: A

Explanation:

The configuration file used by the CPM scanner when scanning UNIX/Linux devices is UnixPrompts.ini. This file is located in the CPM scanner installation folder
and can be customized according to the UNIX/Linux machine’s specific configuration. The file contains parameters that define the prompts and paths for various
commands and files used by the CPM scanner, such as login password, sudo password, sudo error, passwd file, group file, shadow file, and sudoers file.
References: Configure the CPM

Scanner, CPM Scanner parameters file (CACPMScanner.exe.config)

NEW QUESTION 103
When creating an onboarding rule, it will be executed upon .

A. All accounts in the pending accounts list
B. Any future accounts discovered by a discovery process
C. Both “All accounts in the pending accounts list” and “Any future accounts discovered by a discovery process”

Answer: C

Explanation:

According to the CyberArk Defender PAM documentationl, when creating an onboarding rule, it will be executed upon both all accounts in the pending accounts
list and any future accounts discovered by a discovery process. This means that the rule will automatically onboard and provision the accounts that match the rule
criteria, regardless of when they were discovered. The rule will also apply to any new accounts that are discovered by subsequent discovery processes. This way,
the onboarding rule can minimize the time and effort required to securely manage the accounts in the vault.

NEW QUESTION 107
Which CyberArk utility allows you to create lists of Master Policy Settings, owners and safes for output to text files or MSSQL databases?

A. Export Vault Data

B. Export Vault Information
C. PrivateArk Client

D. Privileged Threat Analytics

Answer: B

Explanation:

The Export Vault Information utility is a CyberArk tool that allows you to create lists of Master Policy settings, owners and safes for output to text files or MSSQL
databases. This utility can be used to export various types of information from the Vault, such as accounts, safes, platforms, policies, users, groups, and audit
records. The utility can also generate reports based on predefined templates or custom queries. The utility can be run from the command line or the graphical user
interface. References: Export Vault Information, Export Vault Information Utility

NEW QUESTION 111
Your organization has a requirement to allow users to “check out passwords” and connect to targets with the same account through the PSM.
What needs to be configured in the Master policy to ensure this will happen?

A. Enforce check-in/check-out exclusive access = active; Require privileged session monitoring and isolation = active

B. Enforce check-in/check-out exclusive access = inactive; Require privileged session monitoring and isolation = inactive
C. Enforce check-in/check-out exclusive access = inactive; Record and save session activity = active

D. Enforce check-in/check-out exclusive access = active; Record and save session activity= inactive

Answer: A

Explanation:

The Master Policy in CyberArk allows organizations to permit users to check out a ‘one-time’ password and lock it so that no other users can retrieve it at the
same time. After the user has used the password, they check the password back into the Vault, ensuring exclusive usage of the privileged account. This is
achieved by setting the ‘Enforce check-in/check-out exclusive access’ to active. Additionally, to ensure that all sessions are monitored and isolated, the ‘Require
privileged session monitoring and isolation’ must also be set to active. This combination of settings guarantees both the exclusive access to

privileged accounts and the necessary session monitoring for security and compliance purposesl.

References:

? CyberArk’s official documentation on Account check-out and check-inl.

? The Master Policy overview provided by CyberArk2.

NEW QUESTION 113
The vault supports Subnet Based Access Control.

A. TRUE
B. FALSE

Answer: A
Explanation:
According to the web page in the edge browser, the vault supports Subnet Based Access Control. This is a feature that allows you to restrict access to a key vault

to a specified virtual network and subnet. You can also use firewall settings to deny internet traffic and allow only specific IP addresses. This way, you can
enhance the security and privacy of your key vault datal2

The Leader of IT Certification visit - https://www.certleader.com



CertLeadera 100% Valid and Newest Version PAM-DEF Questions & Answers shared by Certleader

Toader of IT Cortifications https://www.certleader.com/PAM-DEF-dumps.html (239 Q&AS)

NEW QUESTION 117
In order to connect to a target device through PSM, the account credentials used for the connection must be stored in the vault?

A. True.

B. Fals

C. Because the user can also enter credentials manually using Secure Connect.

D. Fals

E. Because if credentials are not stored in the vault, the PSM will log into the target device as PSM Connect.
F. Fals

G. Because if credentials are not stored in the vault, the PSM will prompt forcredentials.

Answer: B

Explanation:

In order to connect to a target device through PSM, the account credentials used for the connection do not necessarily have to be stored in the vault. The user can
also enter credentials manually using Secure Connect, which is a feature that enables users to connect to target systems through PSM without storing the account
credentials in the vault. Secure Connect allows users to provide their own credentials at the time of connection, and these credentials are not saved or managed
by CyberArk. Secure Connect can be used with any connection component that supports PSM, such as RDP, SSH, WinSCP, etc. To use Secure Connect, the
user needs to specify the target system address and the connection component ID in the URL, and then enter the credentials in the PSM login screenl.

The other options are not correct, because:

? A. True. This is not correct, because as explained above, the user can also enter credentials manually using Secure Connect.

? C. False. Because if credentials are not stored in the vault, the PSM will log into the target device as PSM Connect. This is not correct, because PSM Connect is
a predefined user that is created on the PSM server during the installation. This user is used to establish the connection between the PSM server and the target
server, and to run the PSM processes. The PSM Connect user is not used to log into the target device as the end user2.

? D. False. Because if credentials are not stored in the vault, the PSM will prompt for credentials. This is not correct, because this option is essentially the same as
Secure Connect, which is the correct answer.

References:

? 1: Secure Connect

? 2: PSMConnect and PSMAdminConnect

NEW QUESTION 121
When onboarding multiple accounts from the Pending Accounts list, which associated setting must be the same across the selected accounts?

A. Platform

B. Connection Component
C.CPM

D. Vault

Answer: A

Explanation:

When onboarding multiple accounts from the Pending Accounts list, all the selected accounts must be associated with the same platform. This is necessary
because the platform setting determines how the accounts will be managed within CyberArk, including the policies and behaviors that apply to those accounts. If
an account contains dependencies, those dependencies are automatically onboarded with the account. This ensures that all accounts and their dependencies are
managed consistently and according to the correct policiesl.

References:

? CyberArk’s official documentation on Onboarding Accounts and SSH Keys1.

NEW QUESTION 124
What can you do to ensure each component server is operational?

A. Logon to PVWA with v10 Ul, navigate to Healthcheck, and validate each component server is connected to the Vault.

B. Ping each component server to ensure connectivity.

C. Use the PrivateArk client to connect to the Vault server and validate all the services are running.

D. Install the Vault Server interface on a remote machine to avoid interactive logon to the Vault OS and review the ITALog.log through the Vault Server interface.

Answer: A

Explanation:

To ensure that each component server is operational, you can log on to the Privileged Vault Web Access (PVWA) with the version 10 user interface, navigate to
the Healthcheck section, and validate that each component server is connected to the Vault. The System Health dashboard in PVWA provides a high-level visual
representation of the health status of the different CyberArk components, including whether the Vault service is up and whether the component servers are
connectedl.

References:

? CyberArk Docs - Monitor system health

NEW QUESTION 126
Where can a user with the appropriate permissions generate a report? (Choose two.)

A. PVWA > Reports

B. PrivateArk Client

C. Cluster Vault Manager

D. PrivateArk Server Monitor
E. PARClient

Answer: AB

Explanation:
A user with the appropriate permissions can generate a report in the PVWA (Privileged Vault Web Access) under theReports sectionl. Users who belong to the
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group specified in the ManageReportsGroup parameter in the Reports section of the Web Access Options in the System Configuration page are able to generate
reports in the PVWA. By default, this group is the PVWAMonitor groupl. Additionally, reports can be generated using the PrivateArk Client, which is a desktop
application that provides a direct interface to manage the CyberArk Vault and its contents, including the generation of

reports2.

References:

? CyberArk Docs - Reports in PVWAL

? CyberArk Docs - Generate the Report2

NEW QUESTION 131
You are creating a Dual Control workflow for a team’s safe. Which safe permissions must you grant to the Approvers group?

A. List accounts, Authorize account request

B. Retrieve accounts, Access Safe without confirmation
C. Retrieve accounts, Authorize account request

D. List accounts, Unlock accounts

Answer: C

Explanation:

When setting up a Dual Control workflow for a team’s safe in CyberArk’s Privileged Access Management (PAM), the Approvers group must be granted specific
permissions to function effectively within the workflow. The permissions required for the Approvers group are to ‘Retrieve accounts’ and ‘Authorize account
request’. This allows the Approvers to retrieve the necessary account details and also to authorize requests for access as part of the dual control mechanism.
These permissions ensure that the workflow operates smoothly and securely, with the Approvers having the ability to review and approve access requests as
needed.

References: The answer is derived from the best practices and guidelines provided in the CyberArk Defender PAM course and learning resources, which include
the official CyberArk documentation and study guides. Specifically, the CyberArk documentation outlines the importance of the ‘Retrieve accounts’ and ‘Authorize
account request’ permissions for Approvers in a Dual Control workflow

NEW QUESTION 135
Which permissions are needed for the Active Directory user required by the Windows Discovery process?

A. Domain Admin
B. LDAP Admin
C. Read/Write

D. Read

Answer: D

Explanation:

The Active Directory user required by the Windows Discovery process needs to have Read permissions in the OU to scan and all sub-OUs1. This allows the
Discovery process to scan predefined machines for new and modified accounts and their dependencies without requiring elevated privileges such as Domain
Admin or LDAP Admin rights. The Read permission is sufficient for the Discovery process to retrieve the necessary information about the accounts that should be
onboarded into the Vault. References:

? CyberArk’s official documentation on managing discovery processes outlines the permissions required for the Discovery process, including the need for Read
permissions for the Active Directory user performing the discoveryl.

? Additional details on the required credentials for scanning and the Discovery process can be found in the supported target machines section of CyberArk’s
documentation2.

NEW QUESTION 136
The Accounts Feed contains:

A. Accounts that were discovered by CyberArk in the last 30 days

B. Accounts that were discovered by CyberArk that have not yet been onboarded
C. All accounts added to the vault in the last 30 days

D. All users added to CyberArk in the last 30 days

Answer: B

Explanation:

The Accounts Feed is a feature of the CyberArk Privileged Access Security Solution that enables the discovery and provisioning of privileged accounts in the
environment. The Accounts Feed contains the accounts that were discovered by CyberArk that have not yet been onboarded to the Vault. These accounts are
displayed in the Pending Accounts page in the PVWA, where the user can view, analyze, and onboard them according to various criteria. The Accounts Feed
helps the user to identify and manage the unmanaged privileged accounts that pose a security risk1.

The other options are not correct, because:

? A. Accounts that were discovered by CyberArk in the last 30 days. This is not correct, because the Accounts Feed does not contain all the accounts that were
discovered by CyberArk in the last 30 days, but only the ones that have not yet been onboarded. The accounts that were already onboarded to the Vault are not
part of the Accounts Feed, but are displayed in the Accounts page in the PVWAL.

? C. All accounts added to the vault in the last 30 days. This is not correct, because the Accounts Feed does not contain the accounts that were added to the Vault,
but the ones that are waiting to be onboarded. The accounts that were added to the Vault are not part of the Accounts Feed, but are displayed in the Accounts
page in the PVWAL.

? D. All users added to CyberArk in the last 30 days. This is not correct, because the Accounts Feed does not contain the users that were added to CyberArk, but
the accounts that are waiting to be onboarded. The users that were added to CyberArk are not part of the Accounts Feed, but are displayed in the Users page in
the PVWAL.

References:

? 1: Accounts Feed

NEW QUESTION 140
Select the best practice for storing the Master CD.
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A. Copy the files to the Vault server and discard the CD

B. Copy the contents of the CD to a Hardware Security Module (HSM) and discard the CD

C. Store the CD in a secure location, such as a physical safe

D. Store the CD in a secure location, such as a physical safe, and copy the contents of the CD to a folder secured with NTFS permissions on the Vault

Answer: C

Explanation:

The best practice for storing the Master CD is to store it in a secure location, such as a physical safe. The Master CD contains the server key, the public recovery
key, and the private recovery key, which are essential for starting, operating, and recovering the Vault. These keys are sensitive and should be protected from
unauthorized access, loss, or damage. Therefore, storing the CD in a physical safe ensures that the keys are kept in a secure location when not in use, and that
they are available when needed. This is the recommended option by CyberArk1.

The other options are not best practices and should be avoided, as they expose the keys to potential risks, such as theft, corruption, or deletion. Copying the files
to the Vault server and discarding the CD is not secure, as it makes the keys accessible to anyone who can access the Vault server or compromise its security.
Copying the contents of the CD to a Hardware Security Module (HSM) and discarding the CD is not feasible, as the HSM can only store the server key, not the
recovery keys2. Storing the CD in a secure location, such as a physical safe, and copying the contents of the CD to a folder secured with NTFS permissions on the
Vault is not necessary, as it creates redundant copies of the keys that may not be synchronized or updated. Moreover, NTFS permissions are not sufficient to
protect the keys from malicious or accidental actions. References:

? Server Keys - CyberArk, section “Server Keys”

? Store the Server Key in an HSM - CyberArk, section “Store the Server Key in an HSM”

NEW QUESTION 143

In PVWA, you are attempting to play a recording made of a session by user jsmith, but there is no option to “Fast Forward” within the video. It plays and only
allows you to skip between commands instead. You are also unable to download the video.

What could be the cause?

A. Recording is of a PSM for SSH session.

B. The browser you are using is out of date and needs an update to be supported.

C. You do not have the “View Audit” permission on the safe where the account is stored.

D. You need to update the recorder settings in the platform to enable screen capture every 10000 ms or less.

Answer: A

Explanation:

The inability to “Fast Forward” within a video recording in the PVWA and the restriction to only skip between commands suggests that the recording is of a PSM
for SSH session. PSM for SSH sessions are typically recorded as text-based logs that capture command-level activities, which allows for skipping between
commands but not fast- forwarding through a video timeline. Additionally, the lack of an option to download the video is consistent with the behavior of text-based
session recordings, which do not provide a video file for download1.

References:

? CyberArk’s official documentation on Recorded Sessions, which explains the playback functionalities and limitations of different types of session recordings1.

? Information on configuring video and text recordings in PSM, which details how recordings are managed and the options available for different session types2.

NEW QUESTION 147
Which report could show all accounts that are past their expiration dates?

A. Privileged Account Compliance Status report
B. Activity log

C. Privileged Account Inventory report

D. Application Inventory report

Answer: A

Explanation:

The Privileged Account Compliance Status report shows the compliance status of all privileged accounts in the Vault, based on the expiration date and password
change policy. This report can help identify accounts that are past their expiration dates and need to be updated or removed. References:

? [Defender PAM Sample Items Study Guide], page 18, question 90

? [CyberArk Privileged Access Security Documentation], version 12.3, Reports Guide, page 27, Privileged Account Compliance Status report

NEW QUESTION 152
tsparm.ini is the main configuration file for the Vault.

A. True
B. False

Answer: B

Explanation:

tsparm.ini isnot the main configuration file for the Vault. It is one of the several configuration files that control the initial settings and method of operation of the
Server. The main configuration file for the Vault is DBParm.ini, which contains the general parameters of the database, such as the Vault name, the Vault IP
address, the Vault port, the encryption algorithm, the log retention, and the debug mode. References:

? Defender PAM Sample Items Study Guide, page 9, question 92

? CyberArk Privileged Access Security Implementation Guide, page 75, section “DBParm.ini”

? CyberArk Vault Server Parameter Files, page 1, section “TSParm.ini”

NEW QUESTION 156
Due to corporate storage constraints, you have been asked to disable session monitoring and recording for 500 testing accounts used for your lab environment.
How do you accomplish this?

A. Master Policy>select Session Management>add Exceptions to the platform(s)>disable Session Monitoring and Recording policies
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B. Administration>Platform Management>select the platform(s)>disable Session Monitoring and Recording Most Voted
C. Polices>Access Control (Safes)>select the safe(s)>disable Session Monitoring and Recording policies
D. Administration>Configuration Options>Options>select Privilege Session Management>disable Session Monitoring and Recording policies

Answer: D

Explanation:

To disable session monitoring and recording for a large number of accounts due to storage constraints, you would navigate to the Administration section of the
CyberArk Privileged Access Security (PAS) solution, specifically to the Configuration Options. From there, you would select the Privilege Session Management
(PSM) options and disable the Session Monitoring and Recording policies. This action would apply the changes to the specified accounts, thus disabling the
session monitoring and recording features for them1. References: The answer is based on general knowledge of CyberArk PAS and best practices for managing
session policies within the system. For specific steps and detailed procedures, please refer to the official CyberArk Defender PAM course materials and
documentation

NEW QUESTION 157

A recently-hired colleague onboarded five new Local Accounts that are used for five standalone Windows Servers. After attempting to connect to the servers from
PVWA, the colleague noticed that the "Connect" button was greyed out for all five new accounts.

What can you do to help your colleague resolve this issue? (Choose two.)

A. Verify that the address field is populated with an IP or FQDN of each server.

B. Verify that the correct PSM connection component appears within account platform settings.

C. Verify that the address field is blank and that the correct PSM connection component appears within account platform settings.

D. Notify the Windows Team that created the new accounts that the CyberArk PAM solution is not designed to manage local accounts on Windows Servers.
E. Verify that the "Disable automatic management for this account” setting for each account is not enabled.

Answer: ABE

Explanation:

? Verify Server Address: Ensure that the address field is populated with the correct IP or FQDN for each server (Option A).

? Check PSM Settings: Confirm that the correct PSM connection component is specified within the account platform settings (Option B).
? Automatic Management: Check if the “Disable automatic management for this account” setting is not enabled (Option E).

These steps should help in troubleshooting the connection issue in the CyberArk Privileged Access Management (PAM) solution.

NEW QUESTION 161
When managing SSH keys, the CPM stored the Private Key

A. In the Vault

B. On the target server

C.A&B

D. Nowhere because the private key can always be generated from the public key.

Answer: A

Explanation:

When managing SSH keys, the CPM stores the private key in the Vault. The CPM generates a new random SSH key pair and updates the public SSH key on the
target server. The new private SSH key is then stored in the Digital Vault where it benefits from all the accessibility and security features of the Vault. The private
SSH key is never stored on the target server, as this would expose it to unauthorized access or theft. The private SSH key cannot be generated from the public
key, as this would defeat the purpose of

asymmetric encryption. References:

? Manage SSH Keys

? SSH Key Manager

? Use SSH Keys

NEW QUESTION 165

DRAG DROP

ADR Vault became active due to a failure of the primary Vault. Service on the primary Vault has now been restored. Arrange the steps to return the DR vault to its
normal standby mode in the correct sequence.

Inordered Options wderad Responss

Shut down the Privatefsk Server Senice on the
DR Vault
n the FADR im fite, set Fadower Moda = No and
remove the last two lnes < P b
&
| Siant the Privatedrk Dsaster Recovary Samnca |
A. Mastered

B. Not Mastered
Answer: A

Explanation:

? Shut down the PrivateArk Server Service on the DR Vault.

? In the PADR.ini file, set Failover Mode = No and remove the last two lines.

? Start the PrivateArk Disaster Recovery Service.

Comprehensive Explanation: When the primary Vault service has been restored and you need to return the DR Vault to its normal standby mode, the steps are as
follows:

? Shut down the PrivateArk Server Service on the DR Vault to stop the Vault from being active.

The Leader of IT Certification visit - https://www.certleader.com



CertLeader:

Leader of IT Certifications

100% Valid and Newest Version PAM-DEF Questions & Answers shared by Certleader
https://www.certleader.com/PAM-DEF-dumps.html (239 Q&ASs)

? Modify the PADR.ini file by setting Failover Mode to No and removing the last two lines that were added during the failover process. This reconfigures the DR

Vault to standby mode.

? Start the PrivateArk Disaster Recovery Service to complete the transition back to standby model.

References:

? CyberArk Docs - Initiate a DR Failback to the Production Vaultl

NEW QUESTION 170

What is the chief benefit of PSM?

A. Privileged session isolation

B. Automatic password management
C. Privileged session recording

D. ‘Privileged session isolation’ and ‘Privileged session recording’

Answer: D

Explanation:

According to the web search results, the chief benefit of PSM is to provide both privileged session isolation and privileged session recording. Privileged session
isolation means that the PSM server acts as a proxy between the user and the target machine, preventing the user from directly accessing the target machine or
exposing the privileged account credentials. Privileged session recording means that the PSM server captures and stores a video and a transcript of the user’s
activity on the target machine, enabling auditing and monitoring of the privileged session. These benefits help to enhance the security and compliance of the
privileged access management solution, as they prevent credential exposure, restrict unauthorized access, detect malicious activity, and provide evidence for

forensic analysis

NEW QUESTION 175

During a High Availability node switch you notice an error and the Cluster Vault Manager Utility fails back to the original node.
Which log files should you check to investigate the cause of the issue? (Choose three.)

A. CyberArk Webconsole.log

B. VaultDB.log
C. PM_Error.log
D. ITALog.log

E. ClusterVault.console.log

F. logiccontainer.log
Answer: BCE

Explanation:

During a High Availability (HA) node switch, if an error occurs and the Cluster Vault Manager Utility fails back to the original node, you should check the following
log files to investigate the cause of the issue:
? VaultDB.log: This log file contains information related to the database operations within the CyberArk Vault. It can provide insights into any issues that may have

occurred during the database transactions at the time of the node switchl.

? PM_Error.log: The PM_Error.log file records errors encountered by the Password Manager (PM) during its operations. This log can help identify any issues

related to password management that might have contributed to the failure of the node switchl.

? ClusterVault.console.log: The ClusterVault.console.log file includes error, warning, and information messages from the CyberArk Digital Cluster Vault. It is used

for advanced troubleshooting and can reveal details about the error that caused the failback to the original node2.

References:

? CyberArk Docs - Troubleshooting High Availability issues1

? CyberArk Docs - Monitoring the CyberArk Digital Cluster Vault Server2

NEW QUESTION 178

In the screenshot displayed, you just configured the usage in CyberArk and want to update its password.

What is the least intrusive way to accomplish this?

Address:

File Path:

XKML Elernent:
Connection Type:

Paort:

< XML Attnibute:

< Password Regex:
Backup Password File:

Usage Display Mame:

webserveri.lab.local

Cainetpubiwwwroolweb.config

feonfiguration/appSentings/add[@key="PASSWORD ] |

Windows File Sharing

7]

walua

(.

[Select]

Disable automatic management for this account

Reason: Ihlu Reacon

Save Cancel

A. Use the “change” button on the usage’s details page.

B. Use the “change” button on the parent account’s details page.

C. Use the “sync” button on the usage’s details page.
D. Use the “reconcile” button on the parent account’s details page.

Answer: C

Explanation:

The Leader of IT Certification

visit - https://www.certleader.com



CertLeadera 100% Valid and Newest Version PAM-DEF Questions & Answers shared by Certleader

Toader of IT Cortifications https://www.certleader.com/PAM-DEF-dumps.html (239 Q&AS)

A usage is a configuration that allows CyberArk to manage passwords for files, such as XML or INI files, that are stored on remote machines. A usage is
associated with a parent account, which is the account that has access to the file. To update the password of a usage, the least intrusive way is to use the “sync”
button on the usage’s details page. This will synchronize the password value between the Vault and the file, without changing the actual password. The “change”
button will initiate a password change process by the CPM, which will generate a new random password for the usage and the file. The “reconcile” button will
initiate a password reconcile process by the CPM, which will use a reconcile account to reset the password of the usage and the file to the value stored in the
Vault. References: Usages, Manage passwords for usages

NEW QUESTION 180
The password upload utility must run from the CPM server

A. TRUE
B. FALSE

Answer: A

Explanation:

According to the CyberArk documentationl, the Password Upload utility must run from the Central Policy Manager (CPM) server. This utility works by uploading
passwords and their properties into the Password Vault from a pre-prepared file, creating the required environment, when necessary. It is run from a command line
whenever a password upload is requiredl.

NEW QUESTION 184
CyberArk recommends implementing object level access control on all Safes.

A. True
B. False

Answer: B

Explanation:

CyberArk does not recommend implementing object level access control on all Safes. According to the CyberArk documentationl, enabling object level access
control impacts Vault performance. Therefore, it should be used only when necessary and with caution. Object level access control is useful when you need to give
granular permissions to specific passwords or files in a Safe, regardless of the Safe level member authorizations. For example, you can use it to grant access to an
external vendor or technician for a specific password only, without exposing any other passwords or files in the Safe. However, if you do not need this level of
granularity, you can use the regular Safe member authorizations to control user access to the Safe and its contents.

NEW QUESTION 189
When managing SSH keys, the CPM stores the Public Key

A. In the Vault

B. On the target server

C.A&B

D. Nowhere because the public key can always be generated from the private key.

Answer: B

Explanation:

When managing SSH keys, the CPM stores the public key on the target server. The CPM generates a new random SSH key pair and updates the public SSH key
on the target machine. The public SSH key is stored in the home directory of the privileged user on the target machine, usually in the file ~/.ssh/authorized_keys.
The public SSH key is not stored in the Vault, as this would be redundant and unnecessary. The public SSH key cannot be generated from the private key, as this
would defeat the purpose of asymmetric encryption. References:

? Manage SSH Keys

? SSH Key Manager

? Use SSH Keys

NEW QUESTION 190
A Reconcile Account can be specified in the Master Policy.

A. TRUE
B. FALSE

Answer: B

Explanation:

A Reconcile Account is not specified in the Master Policy, but in the Platform settings. The Master Policy defines the general password management settings for
all the accounts in the Vault, such as the frequency of password rotation and verification. The Platform settings define the specific password management settings
for each type of target system, such as the password complexity and the Reconcile Account. References:

? Defender PAM course, Module 2: Password Management, Lesson 2: Master Policy and Platforms, slide 8

? Defender PAM course, Module 2: Password Management, Lesson 3: Reconcile and Logon Accounts, slide 2

? Defender PAM Sample Items Study Guide, Question 37

? CyberArk Privileged Access Security Documentation, Password Management - Master Policy

? CyberArk Privileged Access Security Documentation, Password Management - Platforms

NEW QUESTION 192

You received a notification from one of your CyberArk auditors that they are missing Vault level audit permissions. You confirmed that all auditors are missing the
Audit Users Vault permission.

Where do you update this permission for all auditors?

A. Private Ark Client > Tools > Administrative Tools > Directory Mapping > Vault Authorizations
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B. Private Ark Client > Tools > Administrative Tools > Users and Groups > Auditors > Authorizations tab
C. PVWA User Provisioning > LDAP integration > Vault Auditors Mapping > Vault Authorizations
D. PVWA> Administration > Configuration Options > LDAP integration > Vault Auditors Mapping > Vault Authorizations

Answer: B

Explanation:

To update the Vault level audit permissions for all auditors, you would use the Private Ark Client. Specifically, you would navigate to the Tools menu, select
Administrative Tools, then Users and Groups. Within the Users and Groups section, you would select the Auditors group and go to theAuthorizations tab. Here,
you can manage and update the permissions for the Auditor group, including the Audit Users Vault permission. This ensures that all members of the Auditors
group have the necessary permissions to perform their audit functions within the Vaultl.

References:

? CyberArk’s official documentation on predefined users and groups, which includes information on the Auditor user and the permissions associated with this
rolel.

? Information on the administrative tools available in the Private Ark Client, which are used for managing users and groups, including auditors2.

NEW QUESTION 193
dbparm.ini is the main configuration file for the Vault.

A. True
B. False

Answer: B

Explanation:

dbparm.ini is not the main configuration file for the Vault. It is one of the several configuration files that control the initial settings and method of operation of the
Server. The main configuration file for the Vault is DBParm.ini, which contains the general parameters of the database, such as the Vault name, the Vault IP
address, the Vault port, the encryption algorithm, the log retention, and the debug model. References:

? DBParm.ini - CyberArk, section “Main parameters”

NEW QUESTION 194
The Password upload utility can be used to create safes.

A. TRUE
B. FALSE

Answer: A

Explanation:

The Password Upload utility can be used to create safes, as well as password objects, folders, and platforms. The Password Upload utility works with the
CyberArk Password Vault to create password objects from a passwords list and store them in the Vault. This enables you to upload large numbers of passwords
automatically and makes the Vault implementation process quicker and more automatic. The Password Upload utility initiates the Vault environment required to
store passwords in the safe and start working with them. This includes creating new safes, adding the CPM user as a safe owner, and sharing the safe with the
Password Vault Web Accessl. References:

? 1: Password Upload Utility

NEW QUESTION 198
Which onboarding method would you use to integrate CyberArk with your accounts provisioning process?

A. Accounts Discovery

B. Auto Detection

C. Onboarding RestAPI functions
D. PTA Rules

Answer: C

Explanation:

The Onboarding RestAPI functions are a set of web services that allow you to integrate CyberArk with your accounts provisioning process. You can use the
Onboarding RestAPI functions to create, update, delete, or verify accounts in the CyberArk Vault, as well as to retrieve information about accounts, platforms, and
safes. The Onboarding RestAPI functions are part of the Central Credential Provider component, which is installed on a dedicated server that communicates with
the Vault. References:

? [Defender PAM Course], Module 4: Onboarding Accounts, Lesson: Onboarding

RestAPI Functions

? [Onboarding RestAPI Functions Guide], Introduction

NEW QUESTION 203
Which of the following PTA detections require the deployment of a Network Sensor or installing the PTA Agent on the domain controller?

A. Suspected credential theft

B. Over-Pass-The-Hash

C. Golden Ticket

D. Unmanaged privileged access

Answer: C
Explanation:

According to the CyberArk Defender PAM documentationl, the PTA detection that requires the deployment of a Network Sensor or installing the PTA Agent on
the domain controller is Golden Ticket. A Golden Ticket is a type of attack that involves creating a forged Kerberos Ticket Granting Ticket (TGT) that grants the
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attacker access to any resource in the domain. The attacker needs to compromise the domain controller and steal the KRBTGT account password hash to create
the Golden Ticket. The PTA Network Sensor or the PTA Agent can detect this attack by analyzing the network traffic and identifying anomalies in the Kerberos
protocol, such as TGTs with abnormal lifetime, encryption type, or renewal time. The PTA Server then alerts the security team and provides details about the
attack, such as the source IP, the target domain, and the ticket properties. References:

? PTA Network Sensors - CyberArk

NEW QUESTION 206
You are creating a new Rest API user that utilizes CyberArk Authentication.
What is a correct process to provision this user?

A. Private Ark Client > Tools > Administrative Tools > Users and Groups > New > User
B. Private Ark Client > Tools > Administrative Tools > Directory Mapping > Add

C. PVWA > User Provisioning > LDAP Integration > Add Mapping

D. PVWA > User Provisioning > Users and Groups > New > User

Answer: D

Explanation:

To provision a new Rest API user that utilizes CyberArk Authentication, the correct process involves using the PVWA (Password Vault Web Access). You would
navigate to the User Provisioning section, then to Users and Groups, and select New > User. This allows you to create a new user that can be configured for Rest
APl access with the appropriate authentication method1.

References:

? CyberArk’s official documentation on implementing Privileged Account Security Web Services provides information on using REST APIs to create, list, modify,
and delete entities in PAM - Self-Hosted from within programs and scripts, which includes user provisioningl.

? Additional details on the process and best practices for creating Rest API users can be found in the CyberArk Privileged Access Manager documentation and
training resources

NEW QUESTION 207

A user requested access to view a password secured by dual-control and is unsure who to contact to expedite the approval process. The Vault Admin has been
asked to look at the account and identify who can approve their request.

What is the correct location to identify users or groups who can approve?

A. PVYWA> Administration > Platform Configuration > Edit Platform > Ul & Workflow > Dual Control> Approvers
B. PVWA> Policies > Access Control (Safes) > Safe Members > Workflow > Authorize Password Requests

C. PVWA> Account List > Edit > Show Advanced Settings > Dual Control > Direct Managers

D. PrivateArk > Admin Tools > Users and Groups > Auditors (Group Membership)

Answer: B

Explanation:

In CyberArk’s Privileged Access Management (PAM), the correct location to identify users or groups who can approve a dual-control request is within the
Password Vault Web Access (PVWA). Specifically, you would navigate to the ‘Policies’ section, then to ‘Access Control (Safes)’, and within a safe, you would go
to ‘Safe Members'. Here, under the ‘Workflow’ tab, there is an option to ‘Authorize Password Requests’. This is where the Vault Admin can identify which users
or groups are authorized to approve requests for viewing passwords secured by dual-control.

References: The information is based on the best practices and guidelines provided in the CyberArk Defender PAM course and learning resources, which include
the official CyberArk documentation and study guides.

NEW QUESTION 209
How much disk space do you need on the server for a PAReplicate?

A. 500 GB

B.1TB

C. same as disk size on Satellite Vault
D. same as disk size on Primary Vault

Answer: D

Explanation:

The PAReplicate utility exports the Safe files from the CyberArk Vault to a computer on the local network where the Backup utility has been installed. The Safes
are copied in a similar format and structure to the one in the Server. Therefore, the disk space required on the server for a PAReplicate is the same as the disk
size on the Primary Vaultl. References: Use the CyberArk Backup Process

NEW QUESTION 210

You have been asked to secure a set of shared accounts in CyberArk whose passwords will need to be used by end users. The account owner wants to be able to
track who was using an account at any given moment.

Which security configuration should you recommend?

A. Configure one-time passwords for the appropriate platform in Master Policy.

B. Configure shared account mode on the appropriate safe.

C. Configure both one-time passwords and exclusive access for the appropriate platform in Master Policy.
D. Configure object level access control on the appropriate safe.

Answer: C

Explanation:

One-time passwords and exclusive access are security features that can be configured for a platform in the Master Policy. These features enhance the security
and accountability of shared accounts by ensuring that each password is used only once and by only one user at a time. One-time passwords generate a new
password for each check- out and check-in of an account, preventing password reuse and exposure. Exclusive access prevents multiple users from accessing the
same account simultaneously, avoiding conflicts and confusion. By configuring both one-time passwords and exclusive access for the appropriate platform, the
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account owner can track who was using an account at any given moment and ensure that the passwords are always secure and unique. References
: One-Time Passwords, Exclusive Access, Master Policy

NEW QUESTION 215
Users are unable to launch Web Type Connection components from the PSM server. Your manager asked you to open the case with CyberArk Support.
Which logs will help the CyberArk Support Team debug the issue? (Choose three.)

A. PSMConsole.log

B. PSMDebug.log

C. PSMTrace.log

D. <Session_ID>.Component.log
E. PMconsole.log

F. ITAlog.log

Answer: ACD

Explanation:

When users are unable to launch Web Type Connection components from the PSM server, the CyberArk Support Team will require specific logs to debug the
issue. The logs that are typically helpful in such cases include:

? PSMConsole.log: This log file contains informational messages and errors related to the PSM function, which can help identify issues with the PSM server’s
operationl.

? PSMTrace.log: This log file includes errors and trace messages, which can provide detailed insights into the issues occurring during the PSM server’'s
processesl.

? <Session_ID>.Component.log: This log file contains errors and trace messages related to the connection component, which can be crucial for troubleshooting
issues with launching Web Type Connection components1.

These logs can provide the necessary information to understand the problem and assist the support team in resolving the issue effectively.

References:

? CyberArk’s official documentation on PSM for Web Troubleshooting, which outlines the types of logs available and their purposes in the troubleshooting
processl.

? Additional resources on managing and interpreting PSM logs, which provide guidance on using logs for diagnosing and resolving issues with the PSM server2

NEW QUESTION 219
Which processes reduce the risk of credential theft? (Choose two.)

A. require dual control password access approval
B. require password change every X days

C. enforce check-in/check-out exclusive access
D. enforce one-time password access

Answer: BD

NEW QUESTION 222
You have been asked to identify the up or down status of Vault services. Which CyberArk utility can you use to accomplish this task?

A. Vault Replicator

B. PAS Reporter

C. Remote Control Agent
D. Syslog

Answer: C

Explanation:

The Remote Control Agent (PARAgent) is a CyberArk utility that can be used to monitor the status of Vault services remotely. It can also perform other tasks, such
as starting and stopping the Vault, backing up and restoring the Vault, and running other utilities. The PARAgent communicates with the Remote Control Client
(PARCIient), which is a graphical user interface that displays the Vault status and allows the user to execute commands on the Vault. The PARAgent can also
send SNMP traps to a remote terminal if the Vault service is down. References: How do | monitor the Vault status remotely?, Monitor system health

NEW QUESTION 226
DRAG DROP
Which authorizations are required in a recording safe to allow a group to view recordings?

|
Retrieve accounts/files Required
-
List accounts/files Mot Required
View audit

Access Safe without
confirmation

Create Folders
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A. Mastered
B. Not Mastered

Answer: A

Explanation:

? Retrieve accounts/files: Required

? List accounts/files: Required

? View audit: Required

? Access Safe without confirmation: Not Required

? Create Folders: Not Required

Comprehensive Explanation: To allow a group to view recordings in a recording safe, the required authorizations are Retrieve accounts/files, List accounts/files,
and View audit.

These authorizations enable the group members to access and view the session recordings stored within the safe. The Retrieve accounts/files permission allows
users to retrieve files during PSM sessions. The List accounts/files permission enables users to see the list of accounts and files within the safe. TheView audit
authorization is necessary for users to view the audit records associated with the recordings1.

References:

? CyberArk Docs - Monitor Privileged Sessions

NEW QUESTION 230
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